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EXECUTIVE SUMMARY

Introduction

Objective

Audience

For years, traditional datacenters have encountered problems
stemming from the separation of compute and storage resources. This
separation can negatively affect performance, scalability, and cost.
Hyperconverged solutions, in which compute and storage share a chassis, aim to
fix these problems by bringing resources closer together.

One such solution is the Dell XC630-10 system powered by Intel
processors E5-2630 v3 and using Nutanix software. This solution takes up
minimal space in the datacenter, which could potentially help you save on
power and cooling costs. Its unique architecture combines 1U form factor Dell
XC630-10 appliances, Intel processors, onboard storage, and Nutanix cluster
software in a flexible and scalable package.

In the Principled Technologies datacenter, we set up the Dell and Intel
hyperconverged solution as a Microsoft Windows Server 2012 R2 cluster with
Microsoft Hyper-V. To prove that the solution functioned well with Microsoft
Hyper-V, we tested a mixed workload, which included Microsoft Exchange
Server, Microsoft SQL Server, file and print activity, and disk activity simulating a
web server. Together, this workload mimics the kind of work a small to medium-
sized company might do on a daily basis.

This reference architecture explains our findings and offers a guide and

best practices for implementing this solution in your datacenter.

This reference architecture aims to demonstrate how the Dell XC630-10
system powered by the Intel Xeon processor E5-2630 v3 and using Nutanix
software functioned well with mixed workloads when configured as a Microsoft
Windows Server 2012 R2 cluster with Microsoft Hyper-V. Additionally, it
provides best practices and a configuration guide for setting up this Dell and

Intel solution running Hyper-V in the datacenter of a medium-sized business.

This reference architecture is intended for an audience of IT
administrators at small to medium businesses with several hundred employees.
This reference architecture does not describe every possible configuration of

each component in the Dell and Intel solution.
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PRODUCT OVERVIEW

About the Dell XC630 Web-Scale Converged Appliance
Dell XC Series Web-Scale Converged Appliances, powered by Nutanix

software, let you consolidate compute and storage into a single chassis.
According to Dell, these appliances install quickly, integrate easily into any data
center, and can be deployed for multiple virtualized workloads including
desktop virtualization, database, and private cloud projects. They let your
enterprise grow incrementally with pay-as-you-grow, scale-out expansion;
increase capacity and performance one node at a time; and meet future needs
without over-provisioning.

The Dell XC630-10 is a compact 1U compute/storage node, making it
attractive to companies with limited rack space or those deploying VDI and
other virtualized workloads. It has 10 drive slots that can be populated with up
to four SSDs (two SSDs being mandatory) and up to eight HDDs.

Learn more at www.dell.com/us/business/p/dell-xc-series/pd.

About the Dell Networking S4048-ON top-of-rack switch
The Dell Networking S4048-ON 10/40 GbE top-of-rack Open Networking

switch, Dell’s latest datacenter networking solution, is built to optimize

performance, efficiency, flexibility, and availability in the modern datacenter.

According to Dell, it offers a range of benefits, including:

= Low latency. To deliver the strongest performance, the S4048-ON
leverages a non-blocking architecture to deliver line-rate L2 and L3
forwarding — ideal for use in high-speed, business-sensitive deployments.

= High density. The S4048-ON takes up only a single rack unit but offers 48
dual-speed 1/10GbE (SFP+) ports and six 40GbE uplinks. In addition to
saving space, this specific level of density may simplify your migration to
40Gbps in the core of the datacenter.

=  Flexibility in the datacenter. The S4048-ON includes several
architectural features that can help you keep your datacenter running
smoothly. Its I/O panel to PSU or PSU to I/O panel airflow give you more
flexibility with your hot/cold aisle arrangements, and it offers redundant,
hot-swappable power supplies and fans to reduce the cost of datacenter
maintenance.

Learn more at i.dell.com/sites/doccontent/shared-content/data-
sheets/en/Documents/FY16Q1 201 Dell Networking S4048-
ON_SpecSheet 040215.pdf.
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SOFTWARE SOLUTIONS

Operating systems

About Microsoft Windows Server 2012 R2

About Nutanix OS 4.1

Windows Server 2012 R2, the latest release of this server OS from

Microsoft, includes many new features and enhancements. According to

Microsoft, Windows Server 2012 R2 focuses on four core areas:

Beyond virtualization. Windows Server 2012 R2 provides a robust and
dynamic virtualization platform through Hyper-V, and includes new
features that provide flexible options for delivering cloud services.

The power of many servers, the simplicity of one. Windows Server 2012
R2 offers improvements in its features that allow for better-than-ever
high availability and ease of management for multiple-server
infrastructures.

Every app, any cloud. Windows Server 2012 R2 delivers a scalable and
flexible Web and application platform by providing a consistent and open
set of tools and frameworks that apply to applications on-premises, in the
cloud, or in a hybrid environment.

Modern work style, enabled. Microsoft Windows Server 2012 R2
empowers users and IT staff with remote access to data, applications, and

simpler management tools while strengthening security and compliance.

According to Nutanix, the Nutanix Operating System, NOS 4.1, offers

rich enterprise capabilities to meet the needs of the most demanding

applications and critical infrastructure requirements in the datacenter.

The 4.1 release includes the following new capabilities:

e Metro Availability, which provides continuous data availability for
business-critical applications during planned maintenance or
unplanned disasters that affect entire sites.

e Cloud Connect, which seamlessly integrates public cloud services,
such as Amazon Web Services (AWS), with Nutanix-powered private
cloud environments.

e Encryption Support, encrypting user and application data to a level of
FIPS 140-2 Level 2 compliance.

o Simplified Hypervisor Upgrade, with support for VMware ESXi,
Microsoft Hyper-V, and KVM.

e Security/STIG Enhancements

Dell XC630-10 Nutanix on Hyper-V reference architecture A Principled Technologies reference architecture 6



Learn more at www.nutanix.com/2015/01/29/announcing-general-

availability-nutanix-operating-system-4-1/.

SOLUTION DESIGN AND CONFIGURATION

Overview of the scope of this guide

Before you begin

Assumptions of this guide

In this guide, we will walk through the various aspects of setting up a
working Nutanix cluster on a three-node Dell XC630 appliance configuration. We
will cover the network setup, including cabling, switch configurations, and VLAN
tagging; initial cluster creation for Nutanix and Windows Server 2012 R2; and
cluster storage configuration for a three-node cluster of Dell XC630-10

appliances. We will also highlight best practices as appropriate.

In preparation for setting up your Nutanix environment on Hyper-V with
XC630 hosts, you will need one IP address available for the cluster’s IP address
and at least three IP addresses per host: one each for the host’s CVM, the host’s
management, and the host’s IPMI interface. In our environment, we used VLAN
tagging to keep the IPMI network separate from the CVM traffic, but a flat
network could also be set up to avoid our more complex network design. The
IPMI interfaces are required for successful cluster deployment, even though
their reachability does not affect the normal functioning of the Nutanix cluster
post-install. Also, note that if your IPMI interfaces are not configured with
routable IP addresses, some support and management functionality could
potentially be impacted.

We will assume in this guide that each Dell XC630 appliance has had
Windows Server 2012 R2 pre-installed and the Nutanix Phoenix flashing process
performed already (Phoenix takes care of configuring disks, networking, and
Nutanix Controller VM creation). We also assume the administrator following
this guide has an existing Active Directory server, DNS server, and gateway in
their environment. Before beginning the methodology steps, we will assume
you have configured the CVMs and iDRAC/IPMI interfaces on each host with an
IP address and subnet mask, and provided them with the existing DNS and
gateway addresses.

From a networking perspective, we designed this guide to be
representative of a real-world enterprise environment, rather than a basic flat
network. Though we cover setup for a more complex network infrastructure,
including redundant switches, VLAN tagging to segregate traffic, and virtual link
trunking, Nutanix can be deployed on a Hyper-V environment in a similar

fashion on a simpler network.
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Introduction to Nutanix architecture
Nutanix uses a hyperconverged infrastructure to provide a tiered

storage solution to VMs. Every host in a Nutanix cluster houses a Controller VM
(CVM), which runs the Nutanix software and handles all storage 1/0 operations
for the host’s hypervisor and all the VMs residing on that host. In the case of
Hyper-V, the host appliance’s SSDs and hard disk drives are directly passed
through to the CVM for management.

Administrators can create a storage container from the Nutanix cluster’s
disks to be used as storage for all the cluster’s hosted VMs. Nutanix cluster
nodes typically have a small number of fast but low-capacity SSDs and a larger
number of slower but high-capacity HDDs. Nutanix storage tiering/prioritization
works to move data to the most appropriate location (either local SSDs, cluster
SSDs, or HDDs) based on availability of fast storage and how frequently the data
in question is accessed. By converging compute and storage resources into
single appliance nodes, scaling Nutanix clusters out is easy and flexible.

Solution architecture and diagrams

Every Dell XC630 appliance in a Nutanix cluster has the same basic
configuration: a tier of SSD-based flash storage, a tier of hard disk drives,
compute resources in the form of two Intel Xeon processors E5-2630 v3, and
192 GB of DDR4 RAM. At the hypervisor layer, each host runs Hyper-V on
Windows Server 2012 R2, which hosts a single Nutanix Controller VM, and as

many other VMs as you configure for your environment (see Figure 1).
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Controller
VM

Flash
storage

Hard disk
storage

Dell XC630 host

Figure 1: The structure of each node in our Nutanix cluster.

Once the cluster has been created, the flash and hard disk storage
resources from each node are logically grouped and defined through software
as a storage pool. From there, a container is created and used for housing the
virtual hard disks and virtual machine configuration files for your environment.
Although we did not use these features, Nutanix offers storage efficiency
technologies such as deduplication, which removes duplicate data to increase
the effective amount of storage resources available and accelerate
performance, as well as thin provisioning, which allows a LUN to be created
without allocating physical storage space that would go unused initially (more
physical space is used as the actual space fills up). For more information on
deduplication as provided by Nutanix, go to
www.nutanix.com/products/features/enterprise-storage/deduplication/. Figure

2 shows how the storage for the three-node cluster we tested is configured.
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\\ClusterName-SMB\Container

Storage pool

Flash-1 Flash-2 Flash-3

HDD-1 HDD-2 HDD-3

Figure 2: The Nutanix storage cluster’s container is comprised of the flash and hard disk
storage from each host.

Our environment used redundant 10 Gbps Dell Networking S4048-ON
switches for cluster/VM traffic and live migration, and redundant 1 Gbps Dell
Networking N2024 switches for IPMI traffic. We used VLAN tagging to segregate
the public traffic from the Live Migration traffic, Dell virtual link trunking (VLT)
between the S4048-ON switches, and 1 Gbps links between the S4048-ON
switches and the N2024 switches (see Figure 3).

1Gbps switch <= Pol

T arrrmes MO e
Dell Networking Dell Networking
> Access 100 (IPM) 4048-ON switch 4048-ON switch
VLAN
\ 10- Public (data)
100- Private (data)
i Trunk 101- Live migration
10
100 (untagged)
101

[ 40Gbps
[ 10Gbps
M 1Gbps

Dell XC630 appliances

Figure 3: The network configuration for the Nutanix cluster we tested on Dell XC630 appliances.
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The Dell XC630 is configured (by the Phoenix flashing process) with a
NIC team (configured with switch independent teaming mode and dynamic load
balancing) created from the two 10 Gbps SFP ports on the Intel X520/i350
network daughter card. Two virtual switches come preconfigured as well, one
for traffic between the host and the Nutanix CVM, and one for Nutanix cluster
and VM traffic. We will later create another virtual network adapter on that NIC
team for running live migration traffic once the failover cluster is created (see

Figure 4).

1Gb 1Gb

(unused) (unused)

NIC team

. ExternalSwitch
) InternalSwitch Public-Net (VLAN 10)
Private-Net (VLAN 100) LiveMigration-Net (VLAN 101)

Figure 4: The structure of each XC630 host’s NIC team, formed from the two 10 Gbps ports, and
their virtual switches and network adapters. Note that the 1 Gbps ports are unused.

Creating the Nutanix cluster
1. Perform the following on each of the Controller VMs to configure their IP addresses:

a. Login with the default admin credentials.

b. Using vi, edit /etc/sysconfig/network-scripts/ifcfg-ethO, setting
BOOTPROTO=static, IPADDR=XX.XX.XX.XX,
NETMASK=YY.YY.YY.YY, and GATEWAY=Z%%7.%%.%% .77, using
appropriate values for the IP address, subnet mask, and gateway.
Save and close the file.

c. Usingvi, edit /etc/resolv.conf. Add a new line of nameserver
XX .XX.XX.XX, using an appropriate IP address for your
environment’s DNS server.

d. Restart network services with /etc/init.d/network

restart.
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2. On the Windows 7 management system, be sure that Mozilla Firefox and
Bonjour (which is included with iTunes or downloadable from
support.apple.com/kb/DL999) are installed.

3. Determine the IPv6 service name for one of the Dell XC630 nodes that will
be added to the cluster. IPv6 service names are uniquely generated at the
factory and have the following form (note the final period): NTNX-
system service tag-node location-CVM.local.On the front
left side of the system is a slide-out label that contains the
system service tag (forexample, B57PW12). The node location
is A for one-node blocks.

4. Inthe Windows 7 management system, launch Mozilla Firefox, and in the
URL bar, enter
http://cvm ipvé addr:2100/cluster init.html, replacing
cvm_ipvé addr with the IPv6 service name determined in step 2. For
example, the URL we accessed was http://NTNX-2PSNS52-A-
CVM.local.:2100/cluster init.html. Be careful toinclude the
period after the word “local” in the URL.

' Nutanix Cluster Configuration ® + =N =2 ‘

http://ntnx-2psns52-a-cvm.local.:2100/ cluster_init.htr c ﬁ 8 9 3 # (-] =

CLUSTER CONFIGURATION

NutanGClusted

192168.0.100

er Max Redundancy Fact

2

CVM DNS Servers

192168.0.10

CVM NTP Servers

192168.0.10

Figure 5: Providing a cluster name, external IP, CVM DNS server, and CVM NTP server.
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5. Provide an appropriate name (of 15 characters or fewer) for your Nutanix
Cluster in the Cluster Name field.

6. Provide an appropriate IP address for your Nutanix Cluster in the Cluster
External IP field. This IP can be used to access the web console and nCLI
once the cluster is created.

7. Leave the Cluster Max Redundancy Factor at 2, since we are using only
three nodes. A cluster must have at least five nodes to use a redundancy
factor of 3, but that configuration is beyond the scope of this guide.

8. Provide the IP address(es) of the Active Directory domain controller(s) in the
CVM DNS Servers and CVM NTP Servers fields.

| Nutanix Cluster Configuration x | + E]@
ttp://ntnx-2psns52-a-cvm.local.. 2100/ cluster_init.htm C Searct o8 9 3+ 0 =
CVM DNS Servers
192168.010
CVM NTP Servers:
192168.010
Hypervisor DNS Servers

192168.0.10,88.8.8

Hypervisor NTP Servers

m

Cluster-wide Network settings:

Controller Hypervisor IPMI
Subnet Mask 255255254.0 2552552540 2552552540
Default
" 192168.01 192168.01 192168.01

Gateway

Figure 6: Providing the appropriate subnet masks and default gateways in the Cluster-wide Network settings.

9. Provide the IP address(es) of the Active Directory domain controller(s) as
well as 8.8.8. 8 in the Hypervisor DNS Servers field.

10. Leave the Hypervisor NTP Servers field blank, as this does not apply to a
Hyper-V cluster.
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11. Provide the subnet masks and default gateways for each Controller,
Hypervisor, and IPMI into the Cluster-wide Network Settings table, if they
are not already populated.
/ Nutanix Cluster Configuration x\+ =0 <
. U http://ntrx-2psns52-a-cvmulocal.. 2100/ cluster_init bt e || Q search B U 3 A S

—‘

Discovered nodes:

Select Node Controller IP Hypervisor IP 1PMI IP
B  2PSNS52/A
2PSLS52/A
2PSMS52/A

m

Log Messages:

Figure 7: If IPv6 link-local connectivity is working properly, your nodes should appear in the list of Discovered nodes.

12. Check the box next to each node that you want to add to the cluster.

13. Provide an appropriate IP address for all the components in the cluster, if
the values are not already populated. The discovered nodes are not listed in
a particular order, so be sure to assign the intended IP addresses to each

node.
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| f Sl
fNutanix Cluster Configuration x\\-}- E
@0 http://ntnx-2psns52-a-cvm.local.:2100/ cluster_init.html || Q search w Ba 3y H © =

—‘

Discovered nodes:

Select Node Controller IP Hypervisor IP IPMI IP
@] 2PSNS52/A  192168.0.23 192168.013 192168.0.53
] 2PSLS52/A 192168.0.21 192168.011 192168.0.51
V]  2PSMS52/A  192168.0.22 192168.012 192168.0.52

m

Log Messages:

Figure 8: Provide IP addresses for the Controller, Hypervisor, and IPMI for each discovered node.

14. When you are ready to create the cluster, click Create.

15. Wait until the Log Messages section of the page indicates that the cluster

has been successfully configured. The cluster starts automatically after
creation succeeds.
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Nutanix Cluster Configuration X +

ntnx-2psns52-a-cvm.local.

m

Figure 9: Log Messages output indicating successful creation of the Nutanix cluster.

CvM: 192.168.0.21 Up
Zeus
Scavenger
SSLTerminator
Acropolis
Medusa
DwvnamicRingChanger
Pithos
Stargate
Cerebro
Chronos
Curator
Prism
CIM
AlertManager
Arithmos
Sys5StatCollector
Tunnel
ClusterHealth
BELTIS
NutanixGuestTools

16. Log onto any Controller VM with SSH.

17. Verify that all services are up on all Controller VMs by entering the

up
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP
upP

command cluster status.

8214, 8239, 8240, 8242, 8289, 8303]

10441,
10552,
10589,
12027,
12415,
12432,
12466,
12502,
12520,
12556,
12596,
12615,
12644,
12803,
12820,
12854,
12889,
12896,
12921,

10466,
10579,
10636,
12055,
12444,
12471,
12500,
12531,
12557,
12598,
12628,
12656,
12680,
12832,
12861,
12886,
12961,
12930,
12976,

10467,
10580,
10637,
12056,
12445,
12472,
12501,
12532,
12558,
12599,
12629,
12657,
12681,
12833,
12862,
12887]
12962,
12931,
12977]

10504]
10693]
13430]
12078,

13650]

13021,
13274]

13047, 13048, 13379, 13380]

Figure 10: Verifying that all cluster services are running properly on each node in the cluster.
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18. On the Windows 7 management system, enter the cluster IP address into

the URL bar, and press Enter.
19. Enter a password for the cluster admin account, and re-enter it. Click the

arrow button when finished.

m Nutanix Web Console x \ +

€ @ hitps://192168.0.100:9440/console/=lc o

PR | S

Create a new password for the cluster admin.

NUTANIXX

Figure 11: Providing an admin password for the Nutanix cluster.

20. Enter the admin credentials at the login prompt, and click the arrow button

to login.
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/m MNutanix Web Console x\+ li“i”é‘

€ ) B hitps://192.168.0.100:9440/ console/Zpage/dashboard C || Q Search w B U 3+ A

NutanixCluste
Hyperviser Summary Clusterawide Contreller IOPS - Health Critical Alerts
00 I0PS
Microsoft
Windows Server
HVPel"V 2012R2 0
HYPERVISOR CRITICA
5:00pm 6:00pm 700pm CRITICAL
Storage Summary Clusterawide Contreller 10 B/W Disks 27 ®0 o
You haven't set L
up your VMs 3 @0 ] E
storage. Would
you like to
500mm E00mm +00pm
"""""" o Hosts 3 @0 o
VM Summary Cluster-wide Controller Latency - Data Reslllency Status warning Alerts
3
3 0
VIMS) o — - WARNING
5:00pm 6:00pm 00pm
Data Resiliency possible
Hardware Summary Cluster CPU Cluster Info Alerts Events
Uszage Memory
Usage T
@ Rebuild capacity available
HOSTS i L o
« - it Ly

Figure 12: The Nutanix Web Console dashboard page.
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Configuring Nutanix storage

After creating the cluster, you need to create a storage pool and a

container. For most organizations, creating a storage pool comprising all the

physical disks in the cluster, and then a container using all available capacity in

the storage pool will be suitable.
1. From the Nutanix Web Console main page, click the Home drop-down

menu, and select Storage.
fm Mutanix Web Console X\+ EI@

€ | 8 hitps://192.168.0.100:9440/ console/Zpage/dashboard C || Q search wBa U ¥ 4 0 =

»

NutanixCluste

Hypervisor Suf

Cluster-wide Controller |[GPS

Health Critical Alerts

100 IOFS

Hyper-

HYPERVISOR

Storage Summ

Disks 27 @0 o

You haven't set L
up your VMs 3 @0 o E
storage. Would
you like to
- [ e— £00pm 7-00pm

- U o e Hosts ES @o o
VM Summary Cluster-wide Contreller Latency - Data Reslllency Status warning Alerts

3 im

\MRCY

—_— F— — WARNING
Data Resiliency possible
Hardware Summary Cluster CPU Cluster Info Alerts Events
Uszage Memory
Usage =
3 xce30_1o 1-6 % 13 o @ Rebuild capacity available
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Figure 13: The Storage drop-down menu selection.
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2. Click the + Storage Pool button in the top-right corner. The Create Storage
Pool dialog box appears.

/m MNutanix Web Console X\+ li“i“é‘

€ | @ nhittps//192.168.0.100:9440/ console/#page/storage || Q search WwBe U 3 & @ =
NutanixCluste
Overview - Diagram - Table
Storage Summary Cluster-+wide Controller IOPS - Storage Critical Alerts Storage Events
100 I0PS
You haven't set
up your
storage. Would 0 0
you like to CRITICA EVENT
5:00pm 6:00pm 7:00pm - o
No Contalners Clusterawide Controller 10 B/W
5:00pm 6:000m +:00pm
Capacity Optimization Cluster-wide Controller Latency - Storage Warning Alerts
L1im
5:00pm £:00pm 7-00pm HARKING i
Performance Tier Deduplication
-
—a h
4 T | »

Figure 14: The Nutanix Web Console Storage page.
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3. Provide a name for the storage pool, and be sure “Use unallocated capacity”
is checked, since that will be suitable for most environments.
'm Nutanix Web Console =N el

l./(- | @ https://192.168.0.100:9440/ console/#page/storage vg | | Q, Search | b d | B 3y /i 0 =

A storage pool is a group of physical disks from one or more tiers. Nutanix
recommends creating a single sterage pocl to manage all physical disks within
the cluster.

NAME

StoragePool

CAPACITY

17.87 TiB Use unallocated capacity [#]

| Cancel |

Figure 15: Creating a storage pool in the Nutanix Web Console.
4. Click Save.
5. Onthe Storage page, click the + Container button. The Create Container
dialog box appears.
6. Provide a name for the container, check that the container will be created in
the intended storage pool, and click Save. More options are available by
clicking Advanced Settings, but they are beyond the scope of this guide.
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Enter a name for your container and select a storage pool for it. You can mount the
container as an NFS datastore for all hosts, or select individual hosts.

NAME

Contalner

STORAGE POOL

StoragePool

MAX CAPACITY
17.87TiE

[Physical) Based on sterage pool free unreserved capacity
NFS DATASTORE

Mo hosts can be mounted with an NFS datastore.

The cluster’s hypervisor(s) are Hyper-\/.

o Advanced Settings Cancel

Figure 16: Creating a container in the Nutanix Web Console.

Joining the domain and creating the failover cluster

After creating the storage on the Nutanix cluster, you need to join the
Hyper-V hosts and Nutanix storage cluster to the domain. After that, you have
to create the Hyper-V failover cluster. You will complete all of these steps
through commands in any CVM’s shell.

1. Logonto any CVM in the cluster via SSH.

2. Runthe command setup hyperv.py setup hosts to start
joining the Hyper-V hosts to the domain.

3. When prompted, enter the IP address of the domain controller.
Enter the fully qualified domain name (FQDN) to which the hosts
will be joined. We used test.local.

5. Answer Y or N depending on whether you will use a 10G switch for
the cluster. We answered Y.
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10.

11.
12.

13.

14.

15.
16.

17.
18.

19.

20.

Enter the domain account you will use to join the hosts to a new
domain. We used test.localladministrator.

Provide that domain account’s password.

Provide a name for the Hyper-V cluster.

Provide custom names for your hosts when prompted, or use the
defaults by pressing Enter without entering anything.

Provide a custom name for accessing your Nutanix SMB shares, or
use the default by pressing Enter without entering anything. A
success message is displayed, and the hosts will restart to complete
joining the domain. Allow about 5 minutes before proceeding.

Log onto any CVM in the cluster via SSH.

Run the command setup hyperv.py

create failover cluster to startcreatingthe Hyper-V
failover cluster.

When prompted, provide a custom name for your cluster, or use
the default, as specified in the last set of prompts.

Enter a domain account with local administrator rights on the hosts.
For us, thiswas test.local\ladministrator.

Provide that domain account’s password.

Provide an external IP address to be used for the Hyper-V failover
cluster. The script will add the hosts to the new failover cluster.
Wait until this completes before proceeding.

Enter nc1i into the shell to enter the Nutanix CLI.

Allow your management console workstation to access the cluster
entities by entering the following, using the workstation’s IP address
and subnet mask in place of the placeholder text: cluster add-
to-nfs-whitelist ip-subnet-

masks=ip address/subnetmask.

Specify the timezone of the cluster by entering the following, using
your timezone in place of the placeholder text: cluster set-
timezone timezone=cluster timezone.

Restart all CVMs in the cluster after changing the timezone. Because
a three-node cluster can tolerate only a single CVM unavailable at
any one time, restart them in a series, waiting until one has finished

restarting before proceeding to the next.
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Configuring Hyper-V Manager to use the Nutanix storage cluster SMB share
1. Loginto the Hyper-V Manager.

[is

A

Right-click the Hyper-V Manager, and select Connect to Server.
Type the name of the host you want to add, and click OK.
Right-click the host and select Hyper-V Settings.

Click Virtual Disks, and specify the default folder to store virtual

hard disk files. For us, this was \\hvcluster-

smb\container\disks.
6. Click Virtual Machines and specify the default folder to store virtual

machine configuration files. For us, this was \\hvcluster-

smb\container.

7. Repeat steps 3 through 6 for each Hyper-V host to be configured.

Note: Virtual machines created using Hyper-V should never be

defined on storage using IP-based SMB share locations.

Hyper-V Settings for HVCLUSTER-1 IL‘E-

% Server
B virtual Hard Disks
\thvduster-smb'\container \disks
21 virtusl Machines
Vhvduster-smblcontainer),
L. physical GPUs
Manage RemoteFX GPUs
& NUMA Spanning
Allow NUMA Spanning
%.'fj Live Migrations
2 Simultaneous Migrations
f_"g Storage Migrations
2 Simultaneous Migrations
'J,g. Enhanced Session Mode Folicy
N Enhanced Session Mode
g'H Replication Configuration

Mot enabled as a Replica server

® User

@ Keyboard
Use on the virtual machine
&ﬁ’ Mouse Release Key
CTRL+ALT-HEFT ARROW
",ﬁ- Enhanced Session Mode
Use if available
9= Reset Check Boxes
Reset check boxes

4 Virtual Hard Disks

Specify the default folder to store virtual hard disk files.
|‘|,‘|J1\tduster—smb\,con13iner\disks |

Browse...

Figure 17: Hyper-V Settings for one of our hosts with properly configured storage locations for
virtual hard disks and virtual machine files.
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Configuring Live Migration

Here, we create VLAN 101-tagged virtual switches on each XC630
Hyper-V host’s 10 Gbps NIC Team, and configure them for our failover cluster’s
Live Migration network.

1. Open PowerShell on one of the Hyper-V hosts.
2. Run the following commands to create a virtual NIC and tag it with
VLAN 101:

e Add-VMNetworkAdapter -ManagementOS -Name
LiveMigrationVLAN101l -SwitchName
ExternalSwitch

e Set-VMNetworkAdapterVlan —-ManagementOS -
VMNetworkAdapterName
“LiveMigrationVLAN101” —-Access —-VlanID 101

3. In Windows, navigate to Network Connections, and open the
Properties for the new virtual adapter.
Select Internet Protocol Version 4 (TCP/IPv4), and click Properties.
Provide an IP address and subnet mask for the host’s Live Migration
network.
Repeat steps 1 through 5 for all three hosts.
On one of the hosts, open the Failover Cluster Manager.
Navigate to your cluster’s Networks folder in the left pane, and note
the cluster network whose subnet matches that of the virtual

adapter that was just configured for Live Migration.
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File Action VWiew Help

« | #[m 3=

ﬁ Failover Cluster Manager
P @ HVCluster.test.local
% Roles
[3 Modes
b [ Storage
f% Metworks
Cluster Events

Networks (4)

Mame a Status Cluster Use Information
G Cluster Network 1 ) Up Cluster Only
i\ Cluster Network 2 @ Up Cluster and Client
& Cluster Network 3 () Up Cluster Only
| 7 Cluster Network 4 @ Up Cluster Only

<]

v @&d&r"&lvmﬂ(d

Subnets: 152.168.50.0/24

Summary | Network C ions

ﬁ Live Migration Settings...
View »
@ Refresh

ﬂ Help

Information Details...

Show Critical Events

Properties
Help

B [ g

Figure 18: Failover Cluster Manager’s Networks page; note the network you intend to use for Live Migration traffic.

9. Click Live Migration Settings.
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10. Select the networks to be used for Live Migration, and use the Up
and Down buttons to set their order of preference. We selected
only the virtual NIC we just created, and moved it to the top of the
list.

Networks for Live Migration

Select one or more networks for virtual machines to use for live migration.
Use the buttons to list them in order from most preferred at the top to
least preferred at the bottom,

Cluster Network 4

[ w |
O :ﬁ Cluster Network 2

[] 58 cluster Network 3
O é? Cluster Network 1

Figure 19: Setting the Live Migration network for the failover
cluster. Choose the network noted in the previous section.

11. Click OK.
12. In Failover Cluster Manager, navigate to the cluster’s Roles tab.
13. Click Configure Role...
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File Action View Help

= 7= BE

ﬁ Failover Cluster Manager
A ﬁ HVCluster.test.local
% Roles
E Neodes
I [} Storage
-% MNetworks
Cluster Events

Roles (0) Actions
[ueres ~ |1l >0 | Roles |
MName Status Type Owner Node Priarity Information &7 Configure Role...
Virtual Machines... »
[ Create Empty Role
View >
@ Refresh
E Help
No gems found.
-

This action enables you to select a role that you can configure for high availability.

Figure 20: The Roles screen of the Failover Cluster manager.

14. In the High Availability wizard, on the Before You Begin screen, click

Next.

15. On the Select Role screen, select Virtual Machine, and click Next.
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ﬁ Select Role

Before You Begin
Select Role

Select the role that you want to configure for high availability:

Description:

A virtual machine is a virtualized
computer system nunning on a physical
computer. Multiple virtual machines can
run an one computer.

Select Vitual Machine 1 Generic Service

3 HyperV Replica Broker
I5CS! Target Server
CI5NS Server

& Message GQueuing
%Other Server

I Virtual Machine

& WINS Server

Confimmation

Configure High
Awvailability

Summary

Figure 21: Selecting the Virtual Machine role in the High Availability Wizard.
16. In the Select Virtual Machine screen, select all the VMs you want to

be highly available, and click Next. We created our VMs using the
script outlined in Appendix B, and arranged them as outlined in

Figure 22.

@ Select Virtual Machine

Before You Beain Select the virtual machine(z) that you want to corfigure for high availability.

Select Role

Status Host Server
HVCluster-1 test local
HVCluster-2 test local

Select Virtual Machine Running

Confirmation

Configure High
Awvailability

Summary

Figure 22: Selecting the VMs to configure for high availability.

I kA mdme T

H\VCluster-2 test local
H\VCluster-3 test local
HVCluster-1 test local
HVCluster-2 test local
HVCluster-1 test local
H\VCluster-2 test local

LA imdimem T bmimd Lmmm|

Shutdown Save
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17. Confirm that you have selected the VMs you wish to configure for

high availability, and click Next.

&) High Availability Wizard x|
:h Summary
-_1‘_’:}:.
Before You Begin High availability was successfully configured for the role.
Select Role
Select Virtual Machine
Confimati =i ~
orfimmation =i a .
. < Virtual Machine
Configure High
Availability
All of the virtual machine configurations chosen were successfully made highly
awvailable.
Name Result Description
Vo1
CAS-1 —ri Success
CAS-2 J:--l-- Success v
]

To view the report created by the wizard, click View Report.
To close this wizard, click Finish.

Figure 23: Summary of successful configuration of VMs for high availability.
18. When the Summary page appears with successful results, click
Finish. You can also click View Report... to see a detailed overview of

the tasks completed.
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ABOUT THE TEST ENVIRONMENT

Figure 24 presents the test hardware we used and Figure 25 provides an

overview of the VMs in our testing.

Hardware Quantity
Dell XC630-10 1U appliance 3
Dell Networking S4048-ON 10 Gigabit Switch 2
Dell Networking N2024 Gigabit Switch 2
Figure 24: Test hardware.

VM Application Role Host
SQL-1A SQL Server 2014 Database server 1
SQL-1B SQL Server 2014 Database server 1
sQL-1C SQL Server 2014 Database server 1
SQL-2A SQL Server 2014 Database server 2
SQL-2B SQL Server 2014 Database server 2
sQL-2C SQL Server 2014 Database server 2
SQL-3A SQL Server 2014 Database server 3
SQL-3B SQL Server 2014 Database server 3
SQL-3C SQL Server 2014 Database server 3
CAS-1 Exchange Server 2013 Client Access server 1
MBOX-1 Exchange Server 2013 Mailbox server 1
CAS-2 Exchange Server 2013 Client Access server 2
MBOX-2 Exchange Server 2013 Mailbox server 2
lometer-1A lometer File/Print workload 1
lometer-1B lometer Web server workload 1
lometer-2A lometer File/Print workload 2
lometer-2B lometer Web server workload 2
lometer-3A lometer File/Print workload 3
lometer-3B lometer Web server workload 3

Figure 25: VM overview.
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WORKLOADS

For the validation tests, we set up a mixed workload consisting of some
common business applications and simulated disk activity to run in concert over a 30-
minute period. We ran an OLTP database workload, a Microsoft Exchange workload, and

a simulated file/print server disk workload.

OLTP database workload: DVD Store
To simulate an OLTP workload, we used DVD Store 2.1, an open-source
application that models an online DVD store where customers log in, search for titles,
and purchase movies. We tested with Microsoft SQL Server 2014 as our database
server. Higher thread count and lower think times increase CPU utilization and IOPS. For
more information on DVD Store, please see

en.community.dell.com/techcenter/extras/w/wiki/dvd-store.aspx.

Testing parameters

e Database size: 4 GB
e Number of databases: one per VM
e Number of threads per VM: 64
e Actual test run time: 50 minutes
e Percentage of new customers: 15
e Number of line items: 2
e Think time: 0 seconds
e Warm-up time: 10 minutes
e Ramprate: 10
Additional VM parameters

e Each SQL VM was built with VHDXs for the OS, SQL Database, and SQL Logs
e Each SQL VM was configured as per best practices (E:\SQL Database, F:\SQL
Logs)
Output

e Orders per minute (OPM)
Exchange workload: Microsoft Load Generator 2013

The Microsoft Load Generator 2013 (LoadGen) benchmark performs tasks to
simulate a typical user generating mail activity on Microsoft Exchange Server 2013. We
divided our users into two mailbox databases, each with 100 users, for a total of 200
users/mailboxes. We ensured that performance was within acceptable RPC average
latency thresholds. For more information on Microsoft Load Generator 2013, please see

https://www.microsoft.com/en-in/download/details.aspx?id=40726.

Parameters

e Simulation: 8 hours
e Time: 30-minute duration
e 100 users per database (200 total)
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e Client: Outlook 2007 Cached

e Action profile: Outlook_50

e Mailbox profile: 2 MB
Output

e Success/failure
Disk activity workload: lometer
To simulate disk workloads for a file/print server and for a web server, we used
lometer, an application that allows various access specifications to be run against your
disk I/0 subsystem, including read/write percentages, sequential/random percentages,

and block sizes. For more information on lometer, please see www.iometer.org/.

Testing parameters for file/print server

o Test file size: 2 GB
e Number of outstanding I/Os: 1 per target
e Transfer request size: 512 KB
e Percentage Read/Write Distribution: 20% Write, 80% Read
e Percentage Random/Sequential Distribution: 100% Random
e Transfer delay: 70 ms
e Burstlength:11/0
e Actual test run time: 30 minutes
e Warm-up time: 1 minute
Testing parameters for web server

o Test file size: 2 GB
e Number of outstanding I/Os: 1 per target
e Transfer request size: 512 B
e Percentage Read/Write Distribution: 100% Read
e Percentage Random/Sequential Distribution: 100% Random
e Transfer delay: 0 ms
e Burstlength:11/0
e Actual test run time: 30 minutes
e Warm-up time: 1 minute
Additional VM parameters

e Each test file took up the entirety of a 2GB VHDX, on a separate volume
from the OS
Output

e Latency, IOPS, MBps
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VALIDATION AND TEST RESULTS

Nutanix storage cluster on XC630 supporting all application workloads
e SQL/OLTP: 9 instances of SQL 2014 databases (3 per host) - ~340,000 OPM
e LoadGen/Exchange profile: Outlook_50 — 200 mailboxes
e lometer — File/print workload
e lometer — Web server workload

Our validation test showed that running nine SQL Server 2014 workloads with
DVD Store, two Microsoft Exchange Server 2013 environments, and six disk workloads
could be readily handled by a three-node cluster of Dell XC630 appliances backed by
Nutanix tiered storage. Median CPU usage on each host was 46.8 percent, so your
business would have room to grow from the configuration validated here (see Figure
26). Storage response time remained low (2.1 milliseconds median) after a slight peak
at the start of the testing as the SQL Server 2014 databases loaded into memory, in spite
of the demand placed on the cluster disks by the Intel Xeon processors E5-2630 v3 (see
Figure 27). The average disk queue length peaked at the beginning as well, though after
that point the queue length stayed consistently sub-20 (see Figure 28). Over the course
of the test, the hosts’ disks put out a median of 7,096 IOPS per host (see Figure 29).

Percentage processor time
70

60

e N O 1

50
Node 2
40
= Node 3

30

Percentage

20

lOJ

0 2 3 5 7 8 1012 13 15 17 18 20 22 23 25 27 28

Minutes

Figure 26: Percentage of processor time used by each Dell XC630 host over the test run.
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Average disk queue length
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Figure 27: Average disk queue length for each Dell XC630 host’s disks.

Total disk IOPS

12,000
10,000
8,000

6,000

IOPS

4,000

2,000

0 2 3 5 7 8 1012 13 15 17 18 20 22 23 25 27 28

Minutes

Figure 28: Total disk IOPS performed for each Dell XC630 host’s disks.

Dell XC630-10 Nutanix on Hyper-V reference architecture A Principled Technologies reference architecture 35



Average disk latency (ms)
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Figure 29: Average disk latency for each Dell XC630 host’s disks.

SUMMARY

As this guide has shown, if your business could benefit from using a
hyperconverged computer/storage solution rather than disparate dedicated appliances,
a Nutanix storage cluster powered by Dell XC630 appliances could be the right way to
go. Able to handle nine SQL Server 2014 OLTP workloads at over 340,000 OPM, 200
mailboxes in Microsoft Exchange 2013, as well as file/print and web server disk
workloads, the powerful Dell appliances with the help of Intel processors can keep up
with your current business, with room to grow in the future. With software-defined
tiered storage, high availability, and a redundant network architecture, the small form

factor of the Dell XC630 appliances can help keep your business moving.
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APPENDIX A — DETAILED SYSTEM CONFIGURATION

Figure 30 shows the configuration details of the test system.

System | Dell XC630-10
Power supplies

Total number 2

Vendor and model number Dell OTFR9VAO1

Wattage of each (W) 1100

General

Number of processor packages 2

Number of cores per processor 8

Number of hardware threads per core 2

System power management policy Performance Per Watt (OS)
CPU

Vendor Intel

Name Xeon

Model number E5-2630v3

Socket type FCLGA2011-3

Core frequency (GHz) 2.4

Bus frequency 8 GT/s

L1 cache 32 + 32 KB (per core)

L2 cache 256 KB (per core)

L3 cache 20 MB

Platform

Vendor and model number Dell XC630-10
Motherboard model number OCNCIW

BIOS name and version 1.3.6

BIOS settings Defaults

Memory module(s)

Total RAM in system (GB) 192

Vendor and model number Micron® 36ASF2G72PZ-2G1A2
Type PC4-2133

Speed (MHz) 1,866

Speed running in the system (MHz) 1,866

Size (GB) 16

Number of RAM module(s) 12

Chip organization Double-sided

Rank 2Rx4

Operating system

Name Microsoft® Windows Server® 2012 R2 Datacenter Edition
Build number 9600

Kernel ACPI x64-based PC
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System

Dell XC630-10

Language

English

RAID controller

Vendor and model number

PERC H730 Mini

Firmware version 25.3.0.0016
Cache size (GB) 1
RAID configuration None

Hard disk types

SSDs

Vendor and model number

Intel SSDSC2BA200G3R

Number of disks 2

Size (GB) 200

RPM N/A

Type SATA 6 Gbps

HDDs

Vendor and model number Seagate® ST91000640SS
Number of disks 7

Size (GB) 1,000

RPM 7,200

Type SATA 6 Gbps

Ethernet adapters

Vendor and model number Intel 4-port X520/1350 rNDC
Firmware 15.0.28

Type On-board

USB ports

Number 2

Type USB 2.0

Figure 30: Configuration specifications of our test system.
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APPENDIX B — DETAILED CONFIGURATION METHODOLOGY
Configuring application VMs

Here, we walk through how to configure the applications we tested. We created and configured VMs for
Exchange Server 2013, SQL Server 2014, and lometer for Hyper-V via PowerShell. The Exchange CAS VMs were
configured with two vCPUs and 16 GB of RAM, and the Exchange Mailbox VMs were configured with four vCPUs and 16
GB of RAM. Each SQL Server 2014 VM was configured with four vCPUs and 24 GB of RAM, and each lometer VM was
configured with one vCPU and 4 GB of RAM.

Creating VMs for Hyper-V in PowerShell

We used PowerShell to create the VMs for our application environments. Here is a generic sample of the script
we used, which can be readily adjusted as necessary, replacing the variables and paths as appropriate. We created the
VMs on the host we wanted them to reside on, though the host for each VM can be changed in Failover Cluster Manager
after configuring each VM as a role therein.

New-VM -Name SVMNAME -Path \\PATH\TO\VMs -Generation 2 -SwitchName
ExternalSwitch Set-VM -Name S$VMNAME -MemoryStartupBytes $SRAMAMOUNT -StaticMemory

Set-VMProcessor -VMName S$VMNAME -Count $VCPUCOUNT

New-VHD -Fixed -SizeBytes $VHDSIZE -Path \\PATH\TO\S$SVHDNAME.vhdx
Add-VMHardDiskDrive -VMName S$VMNAME -Path \\PATH\TO\S$VHDNAME.vhdx
Add-VMDvdDrive -VMName S$VMNAME -Path \\PATH\TO\INSTALLMEDIA.iso
$dvd = Get-VMDvdDrive -VMName S$VMNAME

Set-VMFirmware -VMName S$VMNAME -FirstBootDevice $dvd

Start-VM —-Name S$SVMNAME

Configuring Microsoft Exchange 2013 for Load Generator 2013
Preparing AD for Exchange

Perform the following steps once on your infrastructure’s Active Directory server.

1. Insert the Exchange 2012 SP1 Installation ISO in the AD VM DVD drive.
In Windows Explorer, double-click the Exchange DVD icon.
In the Exchange installation folder, hold down shift, and right-click.

Choose Open a command window here.

vk W

Run the following command: Setup.exe /PrepareSchema
/IAcceptExchangeServerLicenseTerms

6. When the previous command completes, run the following command: Setup.exe /PrepareAD
/OrganizationName:”organization name”
/IAcceptExchangeServerLicenseTerms

7. Close the command window when the setup finishes.
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Installing Active Directory Certificate Services

8.
9.

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.

23.
24,
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.

Launch Server Manager, and select Add roles and features.

At the Add Roles and Features Wizard, click Next.

Select Role-based or feature-based installation, and click Next.

Choose Active Directory Certificate Services.

Click Add Features, if prompted, to install any required features.

Click Next.

Click Next.

Click Next.

Choose Certificate Authority and Certification Authority Web Enrollment.

Click Add Features, if prompted, to install any required features.

Click Next.

Leave defaults, and click Next.

Click Install.

Click Close when the install finishes.

Click on the yellow warning symbol in the Server Manager, and click Configure Active Directory
Certificate Services

Leave defaults, and click Next.

Check both Certification Authority and Certification Authority Web Enrollment, and click Next.
Choose Enterprise CA, and click Next.

Choose Root CA, and click Next.

Choose Create a new private key, and click Next.

Leave defaults, and click Next.

Leave defaults, and click Next.

Leave 5 years, and click Next.

Leave default locations, and click Next.

Click Configure.

Close when the configuration finishes.

Open Internet Explorer and navigate to localhost/certsrv/Default.asp to verify that the installation

succeeded.

Installing Exchange Server 2013 SP1 Mailbox and Client Access Server roles

We created two VMs each to serve as Mailbox and CAS servers for our Exchange environments. Edit the

hardware settings in each. The Mailbox servers should have four vCPUs and 16 GB of memory, and the CAS servers
should have two vCPUs and 16 GB of memory. We also provided the Mailbox VMs with an 800GB data disk and a 200GB
logs disk each for Exchange’s database and logs, respectively. We gave each CAS VM a 100GB disk onto which Exchange

will be installed. Set static IPs on all the VMs and join the domain. Run the following commands on both Mailbox VMs

and both CAS VMs as appropriate. By the end of these steps, we had two functional and separate Exchange Server

setups, sharing an Active Directory.
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1. On each Mailbox and CAS server, log into the server using domain administrator credentials.

2. Open Windows PowerShell and run the following command:

Install-WindowsFeature AS-HTTP-Activation, Desktop-Experience, NET-
Framework-45-Features, RPC-over-HTTP-proxy, RSAT-Clustering, RSAT-
Clustering-CmdInterface, RSAT-Clustering-Mgmt, RSAT-Clustering-
PowerShell, Web-Mgmt-Console, WAS-Process-Model, Web-Asp-Netd5, Web-
Basic-Auth, Web-Client-Auth, Web-Digest-Auth, Web-Dir-Browsing, Web-Dyn-
Compression, Web-Http-Errors, Web-Http-Logging, Web-Http-Redirect, Web-
Http-Tracing, Web-ISAPI-Ext, Web-ISAPI-Filter, Web-Lgcy-Mgmt-Console,
Web-Metabase, Web-Mgmt-Console, Web-Mgmt-Service, Web-Net-Ext45, Web-
Request-Monitor, Web-Server, Web-Stat-Compression, Web-Static-Content,
Web-Windows—-Auth, Web-WMI, Windows-Identity-Foundation

3. Restart the server.
Download the Microsoft Unified Communications Managed API 4.0, Core Runtime 64-bit.
(go.microsoft.com/fwlink/p/?linkld=258269)

Run UcmaRuntimeSetup.exe.

When the installation completes, click Finish.

Navigate to the location of the Exchange installation media, and double-click Setup.exe.

o N o w

At the Check for Updates? screen, check the Connect to the Internet and check for updates checkbox, and
click Next.
9. When the updates complete, click Next.
10. At the Introduction screen, click Next.
11. At the License Agreement screen, check the box to accept the terms, and click Next.
12. At the Recommended Settings screen, check the Don’t use recommended settings checkbox, and click Next.
13. At the Server Role Selection, select Mailbox or Client Access role as appropriate, and click Next.
14. At the Installation Space and Location screen, provide an appropriate location for the installation, and click
Next.
15. At the Malware Protection Settings, select yes to disable, and click Next.
16. At the Readiness Checks screen, allow the verification to complete. If there are no failures, click Install.
17. When the installation completes, click Finish, and restart the server.
18. Repeat steps 1 through 17 for the remaining Exchange VMs.
Configuring Exchange
1. On the CAS server, open the Exchange Admin Center by using a browser and navigating to
https://localhost/ecp
Enter the domain administrator credentials, and click Sign in.
If prompted, select the language and time zone, and click Save.

In the left pane, click Mail flow, then click Send connectors.

vk W

On the Send connectors page, click the New icon.
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In the new Send connectors wizard, specify an appropriate name and select Internet as the type. Click Next.
In the Network settings screen, choose MX record associated with recipient domain, and click Next.
In the Address space screen, click Add.

L LN

In the Add domain window, enter the desired address space in the Fully Qualified Domain Name (FQDN)

field, and click Save.

10. Click Next.

11. In Source server screen, click the Add icon.

12. In the Select a Server window, select the mailbox server, click Add, and click OK.

13. Click Finish.

14. In the left pane of the EAC, click servers, select the name of the CAS server, and click Edit.

15. Click Outlook Anywhere, and enter the appropriate FQDN of the Client Access Server for the external and
internal hostname field. For example, exchangeserver.test.local.

16. Choose NTLM as the authentication method, and click Save.

17. Click Virtual Directories, and click the Configure external access domain icon.

18. In the Select the Client Access servers to use with the external URL window, click Add.

19. Select the CAS server, and click Add. Click OK.

20. Type the FQDN of the CAS server in the Enter the domain, and click Save.

21. Log into the Active Directory server using administrator credentials, and complete the following steps:

a. Open Server Manager, then click Tools=>DNS

b. In DNS Manager, expand the Active Directory server name—>Forward Lookup Zones—>test.local in
the left pane.

C. Inthe right pane, verify or create the DNS records as presented in Figure 31.

Type Ho.st or.child FQDN FQDN of mail
domain/alias name server

Mail Exchanger (MX) | Leave blank domain.com casserver.domain.com

Alias (CNAME) Autodiscover Autodiscover.domain.com | casserver.domain.com

Alias (CNAME) Owa Owa.domain.com casserver.domain.com

Figure 31: DNS records.

22. Log back into your CAS server.
23. In the Exchange Power Shell, run the following commands replacing “SHostName” with the host name (not
FQDN) of your CAS server.

Set-EcpVirtualDirectory "S$SHostName\ECP (Default Web Site)" -InternalUrl
((Get-EcpVirtualDirectory "S$HostName\ECP (Default Web
Site)") .ExternalUrl)

Set-WebServicesVirtualDirectory "S$HostName\EWS (Default Web Site)" -
InternalUrl ((get-WebServicesVirtualDirectory "S$HostName\EWS (Default Web
Site)") .ExternalUrl)
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Set-ActiveSyncVirtualDirectory "S$SHostName\Microsoft-Server-ActiveSync
(Default Web Site)" -InternalUrl ((Get-ActiveSyncVirtualDirectory
"SHostName\Microsoft-Server-ActiveSync (Default Web Site)") .ExternalUrl)

Set-OabVirtualDirectory "S$HostName\OAB (Default Web Site)" -InternalUrl
((Get-OabVirtualDirectory "S$HostName\OAB (Default Web
Site)") .ExternalUrl)

Set-OwaVirtualDirectory "SHostName\OWA (Default Web Site)" -InternalUrl
((Get-OwaVirtualDirectory "SHostName\OWA (Default Web
Site)") .ExternalUrl)

Set—-PowerShellVirtualDirectory "S$SHostName\PowerShell (Default Web Site)"
-InternalUrl ((Get-PowerShellVirtualDirectory "S$HostName\PowerShell
(Default Web Site)") .ExternalUrl)

Get-0OfflineAddressBook | Set-OfflineAddressBook -
GlobalWebDistributionEnabled $True -VirtualDirectories $Null

24. Create a folder at the root of C: on the CAS server, and share it to Everyone with read/write permissions.
25. Log back into the Exchange admin center, and navigate to Servers—>certificates.

26. Choose the CAS server in the drop-down menu, and click the plus sign to create a new certificate.
27. Choose Create a request for a certificate from a certification authority, and click Next.

28. Name the certificate, and click Next.

29. Do not request a wildcard certificate, and click Next.

30. Click Browse, choose the CAS server, and click Ok. Click Next.

31. Leave defaults, and click Next.

32. Leave defaults, and click Next.

33. Enter your organization information, and click Next.

34. Enter the path to the share you created on the CAS server, and click Finish. Example:

\\cas\share\myrequest.REQ

35. Log into the AD server, and open Internet Explorer.

36. Browse to localhost/CertSrv

37. Click Request a certificate.
38. Choose advanced certificate request.

39. Choose Submit a certificate request by using a base-64-endcoded CMC...
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40. Open Windows Explorer and navigate to the share folder on the CAS server where the certificate request is
stored.

41. Open the certificate with notepad and copy the content between BEGIN NEW CERTIFICATE REQUEST and
END NEW CERTIFICATE REQUEST.

42. Paste the copied content into the Saved Request window.

43. Choose Web Server in the Certificate Template drop-down menu, and click Submit.

44. Choose Base 64 encoded, and download the certificate.

45. Copy the new certificate into the share folder on the CAS server.

46. Log back into the CAS server and open the Exchange Admin Center.

47. Go to servers—>certificates, and highlight the certificate you began before (should say Pending request in the
status column).

48. Click Complete on the right side.

49. Type the path to the certificate, including the certificate name, and click ok. Example:
\\cas\share\certnew.CER

50. Verify that the status has changed to Valid.

51. Edit the new entry, and click Edit.

52. Go to services and check SMTP and IIS, click Save.

53. On the warning message, click yes.

54. Perform the following steps on the CAS and AD servers:

Click Start, and type MMC

Click File>Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates>Trusted Root Certificate Authorities=> Certificates.

Click Action>All Tasks—=> Import.

Click Next.

j. Browse to the share folder on the CAS server, and choose the new certificate you created. Click
Next.

k. Leave defaults, and click Next.

I.  Click Finish.

m. On the Import was successful message, click OK.
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55. Log into the CAS server, and open the Exchange admin center.

56. Navigate to servers—>databases.

57. Restart the Microsoft Exchange Information Store service on the MB server.

58. Using the Edit button, disable the maintenance schedule and enable circular logging for each mailbox
database.

59. Dismount and remount the databases.

Dell XC630-10 Nutanix on Hyper-V reference architecture A Principled Technologies reference architecture 44


file://///cas/share/certnew.CER

60.

61.
62.

Open Exchange Management shell, and enter the following to move the paths of the default mailbox:

Move-Databasepath “DatabaseName” -EdbFilepath “E:\Newlocation\DBname.edb”
-LogFolderpath “F:\Newlocation”

When prompted, type A and press enter.
Open Exchange Management Shell, and enter the following:

Get-OutlookAnywhere |Set-OutlookAnywhere -ExternalHostname cas.domain.com
-DefaultAuthenticationMethod NTLM -ExternalClientsRequireSsl S$true

Installing and configuring the Exchange 2013 mail test clients and completing LoadGen
configuration on the Exchange 2013

For our testing, we used one virtual client machine to run each instance Load Generator 2013. To create the mail
clients, we installed several software components. We followed this process for each installation:

Installing Windows Server 2008 R2 SP1 Enterprise Edition

1.
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Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.

At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Click the | accept the license terms checkbox, and click Next.

Click Custom.

Click Next.

At the User’s password must be changed before logging on warning screen, click OK.

Enter the desired password for the administrator in both fields, and click the arrow to continue.

. At the Your password has been changed screen, click OK.

. Click Start, type change power-saving settings and press Enter.
. Click Change plan settings.

. Change the Turn off the display drop-down menu to Never.

14.

Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization screens.

To set up this server, we had to install several additional software components. The following subsections detail

the necessary installation processes.

Joining the domain

1.
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Set a static IP.

Select Start—>Control Panel>Network Connections—>Local Area Connection.

Click Properties.

Highlight Internet Protocol (TCP/IP), and click Properties.

Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the
Preferred DNS server field. Click OK.

Right-click My Computer, and select Properties.

Under the Computer Name tab, click Change.
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8. Inthe Computer Name Changes screen, under the Member of section, select the Domain radial box, and
type test.local.

9. Select OK to start joining the domain.

10. When the screen appears asking for a person qualified on the domain, type Administrator as the
username and Password]l as the password.

11. At the Welcome pop-up window and the window warning that you must reset the computer for the changes
to take effect, click OK.

12. At the System Properties screen, click OK.

13. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services
1. Click Start>Administrative Tools—> Server Manager.

2. On the left pane, click Roles.

3. Click Add Roles.

4. Click the Application Server checkbox.

5. When the Add features required for Application Server? screen appears, click Add Required Features.

6. Click Next.

7. Click Next.

8. At the Select Role Services page for Application Server, click the Web Server (1IS) Support checkbox.

9. Click Add Required Support Role Services.

10. Click Next.

11. Click Next.

12. At the Select Role Services page for Web Server (IIS), click IS 6 Management Compatibility, ASP, and CGI
checkboxes; and click Next.

13. Click Install.

14. Click Close.

Installing Load Generator

Download and install Load Generator 2013 using all defaults.

Importing the certificate and editing the hosts file

Click Start, and type MMC.

Click File>Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates=>Trusted Root Certificate Authorities—=> Certificates.
Click Action>All Tasks=> Import.

Click Next.

10. Browse to the share folder on the CAS server, and choose the new certificate you created. Click Next.

=

© 0N U WN

11. Leave defaults, and click Next.
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12. Click Finish.

13. On the Import was successful message, click OK.

14. Open the Notepad program, and use File=>Open to open the hosts file stored at
C:\Windows\System32\drivers\etc.

15. Add the IP and FQDN of the CAS server.

16. Save and close Notepad.

Preparing Load Generator
1. Loginto the mail client.
Select Start—=>All Programs—> Microsoft Exchange—> Exchange Load Generator 2013.
When the Load Generator screen appears, select Start a new test.
Select Create a new test configuration, and click Continue.
Change the total length of simulation to 1 hour.

o vk wNnN

In the Specify test settings screen, type Password]l as the Directory Access Password and Mailbox Account
Master Password, and click Continue with recipient management.
Create 750 users in the Mailbox Database, and click Continue.

® N

To accept defaults for Advanced recipient settings, click Continue.

9. Inthe Specify test user groups screen, select the plus sign to add a user group.

10. Change the Client Type to Outlook 2007 Cached, the action profile to Outlook_200, and the Mailbox size to
250 MB, and click Continue.

11. In Remote configurations, click Continue.

12. Click Save the configuration file as, and name it testcfg.xml

13. Click Start the initialization phase (recommended before running the test).

14. Once you have initialized the database, create a backup copy of the Exchange mailbox databases.

Installing and configuring lometer
1. Onthe lometer VMs, navigate to sourceforge.net/projects/lometer/files/lometer-stable/1.1.0/lometer-

1.1.0-win64.x86 64-bin.zip/download in a web browser.

Run the installer wizard with defaults.

Launch lometer.

In the Topology pane, click the manager with the VM’s host name.

In the Disk Targets tab, check the box next to the empty disk to be used for testing.
In the Access Specifications tab, click New.

Select the new specification, and click Edit.

Set the parameters based on the workload you want to test.

Click OK.

10. Click Add.

11. In the Test Setup tab, enter the run time details and provide a description for the test.
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12. When ready to test, click the green flag button, and provide an output file path.
Installing Microsoft SQL Server 2014
1. Insert the installation DVD for SQL Server 2014 into the DVD drive.
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10.

11.
12.

13.
14.
15.
16.

17.
18.
19.
20.
21.
22.
23.

24.
25.
26.

Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2014 DVD, and
double-click.

If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core
role.

In the left pane, click Installation.

Click New installation or add features to an existing installation.

At the Setup Support Rules screen, wait for the check to complete. If there are no failures or relevant
warnings, click OK.

Select the Evaluation edition, and click Next.

Click the checkbox to accept the license terms, and click Next.

Click Install to install the setup support files.

If there are no failures displayed, click Next. You may see a Computer domain controller warning and a
Windows Firewall warning. For now, ignore these.

At the Setup Role screen, choose SQL Server Feature Installation.

At the Feature Selection screen, select Database Engine Services, Full-Text Search, Client Tools Connectivity,
Client Tools Backwards Compatibility, Management Tools — Basic, and Management Tools — Complete. Click
Next.

At the Installation Rules screen, once the check completes, click Next.

At the Instance configuration screen, leave the default selection of default instance, and click Next.

At the Disk space requirements screen, click Next.

At the Server configuration screen, choose NT Service\SQLSERVERAGENT for SQL Server Agent, and choose
NT Service\MSSQLSERVER for SQL Server Database Engine. Change the SQL Server Agent Startup Type to
Automatic. Click Next.

On the Data Directories tab, enter the SQL Server directories of the data and logs volumes created earlier.
At the Database Engine Configuration screen, select Mixed Mode.

Enter and confirm a password for the system administrator account.

Click Add Current user. This may take several seconds.

Click Next.

At the Error and usage reporting screen, click Next.

At the Installation Configuration rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Close.

Download and install Cumulative Update 6 for SQL Server 2014 at support.microsoft.com/en-

us/kb/3031047.
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Configuring the database workload client
For our testing, we used a virtual client for the Microsoft SQL Server client. To create this client, we installed
Windows Server 2008 R2, assigned a static IP address, and installed .NET 3.5.

Configuring the database

We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the
parameters for our 4GB database size and the database platform on which we ran, Microsoft SQL Server 2014. We ran

the Install.pl script on a utility system running Linux. The database schema was also generated by the Install.pl script.

After processing the data generation, we transferred the data files and schema creation files to a Windows-
based system running SQL Server 2014. We built the database in SQL Server 2014, and then performed a full backup,
storing the backup file on the C: drive for quick access. We used that backup file to restore the server between test runs.

The only modification we made to the schema creation scripts were the specified file sizes for our database. We
deliberately set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the
test. Besides this file size modification, the database schema was created and loaded according to the DVD Store

documentation. Specifically, we performed the following steps:

1. We generated the data and created the database and file structure using database creation scripts in the

DS2 download. We made size modifications specific to our database and the appropriate changes to drive
letters.

We transferred the files from our Linux data generation system to a Windows system running SQL Server.
We created database tables, stored procedures, and objects using the provided DVD Store scripts.

We set the database recovery model to bulk-logged to prevent excess logging.
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We loaded the data we generated into the database. For data loading, we used the import wizard in SQL
Server Management Studio. Where necessary, we retained options from the original scripts, such as Enable
Identity Insert.
We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
We updated statistics on each table according to database-creation scripts, which sample 18 percent of the
table data.
8. Onthe SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL)
script:
USE [master]
GO
CREATE LOGIN [ds2user] WITH PASSWORD=N'"',

DEFAULT DATABASE= [master],

DEFAULT LANGUAGE= [us_english] ’

CHECK EXPIRATION=OFF,

CHECK POLICY=OFF
GO
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9. We set the database recovery model back to full.

10. We created the necessary full text index using SQL Server Management Studio.

11. We created a database user and mapped this user to the SQL Server login.

12. We then performed a full backup of the database. This backup allowed us to restore the databases to a
pristine state relatively quickly between tests.

Running the test
Test start and run times

We ran the workloads with one client per target database. The specific testing parameters we used for the

benchmark are included below.
About running the DVD Store tests

We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store
outputs an orders-per-minute metric, which is a running average calculated through the test. In this report, we report
the aggregate OPM reported by the clients for each run.

Each complete test cycle consisted of the general steps listed below.

Clean up prior outputs from the target system and the client driver system.
Drop the database from the target servers.

Restore the database on the target servers.

Shut down the target.

Reboot the host and client systems.
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Wait for a ping response from the server under test (the hypervisor system), the client system, and the
target.

Let the test server idle for 10 minutes.

Start the DVD Store driver on each client.

® N

We used the following DVD Store parameters for testing:

dsZ2sglserverdriver.exe --target=<target IP> --ramp rate=10 --run time=20
-—n_threads=64 --db size=4GB --think time=0 --detailed view=Y --
warmup time=10 --csv output=<drive path>
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APPENDIX C —5S4048-ON SWITCH CONFIGURATION

! Version 9.8 (0.0P5)

! Last configuration change at Sat Sep 22 06:03:25 2015 by admin
! Startup-config last updated at Sat Sep 22 05:38:40 2015 by default

boot system stack-unit 1 primary system: A:
boot system stack-unit 1 secondary system:

redundancy auto-synchronize full
|

hostname Switch-A
|

default-vlan disable
|
protocol spanning-tree rstp
no disable
bridge-priority O
|
vlt domain 100
peer-link port-channel 100
back-up destination 192.168.0.82
|

stack-unit 1 provision S4048-ON
|
interface TenGigabitEthernet 1/1
description "uplink to N2024 switch"
no ip address
mtu 12000
speed 1000
|
port-channel-protocol LACP
port-channel 111 mode active
dampening 10 100 1000 60
no shutdown
|
interface TenGigabitEthernet 1/2
description "XC-node-la"
no ip address
mtu 12000
portmode hybrid
switchport
no shutdown
|
interface TenGigabitEthernet 1/3
description "XC-node-2a"
no ip address
mtu 12000
portmode hybrid
switchport
no shutdown
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interface TenGigabitEthernet 1/4
description "XC-node-3a"
no ip address
mtu 12000
portmode hybrid
switchport
no shutdown
|
!
interface fortyGigE 1/49
description VLT-peerlink
no ip address
no shutdown
|
interface fortyGigE 1/50
description VLT-peerlink
no ip address
no shutdown
|
interface ManagementEthernet 1/1
ip address 192.168.0.81/23
no shutdown
|
interface Port-channel 100
description "VLTi - interconnect link"
no ip address
channel-member fortyGigE 1/49,1/50
no shutdown
|
interface Port-channel 111
description lacp to dell tor
no ip address
mtu 12000
switchport
vlit-peer-lag port-channel 100
no shutdown
|
interface Vlan 1
|
interface Vlan 10
description public-net
no ip address
tagged TenGigabitEthernet 1/2-1/13
tagged fortyGigE 1/51
tagged Port-channel 100,111
no shutdown
|
interface Vlan 100
description priv-net
no ip address
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mtu 12000

tagged fortyGigEkE 1/51

tagged Port-channel 100,111

untagged TenGigabitEthernet 1/2-1/13
no shutdown

interface Vlan 101
description Live-Migration
no ip address

mtu 12000

tagged TenGigabitEthernet 1/2-1/13
tagged Port-channel 111
no shutdown

ip ssh server enable

protocol 1lldp

advertise management-tlv system-description system-name

!

line
line
line
line
line
line
line
line
line
line
line
|

reload-type
boot-type normal-reload
config-scr-download enable

end

console O

vty
vty
vty
vty
vty
vty
vty
vty
vty
vty

0
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